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Questions & Answers

Nine Hole Courses

Q. Is there anything special I need to know about building a Club document for a
club that has a 9-hole course?

A. You don’t need to do anything special for a 9-hole golf course, just enter the
information for one nine and however many tees there are at the course.  Later,
when you select the course as one you play, you can enter 9-hole rounds or 18-hole
rounds in which you play the same nine twice.  Remember that the hole handicaps
on a 9-hole course are from 1 through 9.  If the 9-hole course has separate “front side
tees” and “back side tees” for golfers to play 18 holes from different tees, make two
nines - one for the front side tees and one for the back side tees – just like a regular
18-hole course.

Q. How about when there’s an 18-hole course there too?

A. You have a couple options here.  If you never play rounds that include a side on
the 18-hole course plus a side on a 9-hole course, enter them as separate courses
(this is because Golf Personal allows you to select just one course when recording a
round).  If however, you play rounds that include both kinds of courses, you’ll need
to enter a course with nines that reflect all those you might play in a round.  This
may mean you will want to enter a course twice, in effect — once as an 18-hole
course and then again as nines on another course.

Courses with More than Two Nines

Q. My course has several nines available for play.  How do I set them up?

A. Some golf facilities have three or more 9-hole courses or links that you may play
in various orders.  For such a facility, enter one course and as many nines as are
appropriate.  You will need Course and Slope Ratings for each of the nines individu-
ally, and you’ll need to enter them for each side on the Club document.  If the
scorecard doesn’t provide the 9-hole ratings and slopes, call the club and ask for
them.  If you have 18-hole ratings and slopes available for “combinations” of the
nines, you can estimate the 9-hole ratings using the Calculator (see Chapter 7).
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Q. What if I can’t find 9-hole Course and Slope Ratings?  Can I estimate them?

A. You may be able to determine or estimate the correct 9-hole values from avail-
able 18-hole Course and Slope Ratings.  Course Ratings for 9 holes are about half of
an 18-hole Course Rating – numbers like 34.2 or 36.0.  Slope Ratings for 9 holes are
about equal to 18-hole Slope Ratings – numbers like 113 or 125.  Another way to look
at it is that 18-hole Course Ratings are the sum of the 9-hole Course Ratings and 18-
hole Slope Ratings are the average of the 9-hole Slope Ratings.  For courses with 3
nines, use the Calculator (see Chapter 7) to estimate the 9-hole ratings.

Q. The hole handicaps are 1 through 9 on all the different nines.  Will Golf Personal
be able to tell where I get my strokes?

A. Sure.  You’ll get strokes first on the number 1 handicap hole on the front side
(the first side you play), then the number 1 handicap hole on the back side, etc.

Tees I Don’t Play

Q. Do I have to enter all those other tees that I never play when I’m building a new
Club document?

A. This is your call.  Enter them if you wish, otherwise don’t include them.  If you
think you might exchange a Club document with someone else who uses Golf
Personal, you might enter all the information — you will save them some trouble
locating a scorecard with information for any tees you omit.

Two Tees of the Same Color

Q. Our club has one set of tee markers used by different kinds of golfers (like
Ladies and Juniors, or Seniors and Executives).  Each of these different categories of
golfers have different par, hole handicapping or Course Ratings.  How do I create
the tees properly in Golf Personal?

A. Create a Tee for each category of golfer that has different requirements.  If the
Ladies and the Juniors both play from the yellow tees, add a tee for the Ladies and a
tee for the Juniors.  Make each yellow and give them an appropriate name (maybe
something like “Ladies’ Tees” and “Junior Tees”), then fill in the rest of the informa-
tion about each.  It’s fine for two tees to use the same color markers.  The only
requirement is that the tees don’t use the same name.

Automatic Filling Par and Handicap Strokes

Q. When I enter hole par and handicaps for the men’s tees, they get carried for-
ward into the women’s tees automatically.  Then, I have to change them all because
some pars and most handicaps are different for women.  Is there a better way?
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A. Yes.  Add just the men’s tees.  Enter the information for the men’s tees and save
the document if you wish.  Then, add the women’s tees.  You’ll have to enter pars
and handicaps for the women’s tees, but it won’t change any data already entered
for the men’s tees.  Plus, if there is more than one women’s tee, your new informa-
tion will be automatically entered for those tees.

“Magic Tabbing” Strangeness

Q. When I’m entering hole handicap numbers and I get to the number 1 handicap
hole, it doesn’t automatically advance to the next hole like other numbers.  What’s
wrong?

A. Nothing except your Macintosh can’t read your mind.  It’s impossible to tell,
after you’ve entered the number 1, whether you intend it to be the number 1 handi-
cap hole or you’re about to key the second digit in the number 11, 13, 15, etc.  As a
result, if you intend the hole handicap to be 1, you’ll have to TAB to the next hole
yourself.  Incidentally, the same thing occurs when you enter a hole score of 1, too –
but that’s quite a bit more rare and you probably won’t mind the inconvenience.

Q. When I’m entering hole lengths (yardages) less than 70 yards, there’s no auto-
matic tabbing.  When I try to enter a length greater than 699 yards, it tabs before I
can enter the last number.  Huh?

A. “Magic Tabbing” occurs only when an entered yardage is between 70 and 699
yards – which accommodates almost every hole you’ll encounter.  To continue from
a shorter yardage, just hit the TAB key.  To enter a longer yardage, key the first two
numbers, click just to the right of the second digit, then key the third number.  These
extreme yardages are fairly rare, but they do occur sometimes.

Tees in Length Order

Q. When I created my Club document, I created the tees in a certain order.  After
I’ve saved the document and reopened it, the tees are in a different order.  What’s
the deal?

A. When a Club document is saved, the tees are saved in order of total length
(longest first) for all nines.  This is usually how they’re printed on a scorecard, too,
and it’s the order Golf Personal presents them in a Club document and on a Score-
card.
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Deleting Courses, Nines and Tees

Q. I followed the instructions for deleting a course (or a tee or a nine), but the
Delete… item in the Edit menu is still dim, and so is the Delete (trash can) button
on the toolbar.  Why can’t I delete?

A. You’re trying to delete the last (only) course at the club, or the only tee or nine
on the course.  On a Club document, at least one course is required.  On a course, at
least one nine and one tee is required.  And, of course, you can’t delete the one club
on a Club document.

The Need for Speed

Q. I want to set up Golf Personal to open fast, with a scorecard set to my regular
course.  What’s the best way to do this?

A. From the Finder, make an alias of the application (select the Golf Personal
application icon - shown at the left, choose Make Alias from the File menu) and put
it on your desktop or in your Apple Menu Items folder (inside your System Folder).

With Golf Personal, make a blank scorecard for yourself (either by opening your
Player document and choosing Blank Scorecard for… from the Golf menu or by
option-double-clicking your name in the Players palette).  Select your regular course
and make it your “preferred” course by clicking the Set button in the scoring area.
Close the scorecard and save your Player document, if it’s open.  Open the Prefer-
ences dialog (choose Preferences… from the Edit menu), select the Favorite Player
tab, and click the Set button.  Locate your Player document and click Open to make
it the Favorite Player document.  Select the Startup tab and click the “Open a
Scorecard for the Favorite Player” button.  Click OK to make these your new pre-
ferred settings.

Now, whenever you need to enter a new round, just double-click the alias for Golf
Personal (or select it from the  menu).  The application will start with a new blank
scorecard for you, already set to your regular course.  Just enter your round, save it,
close the Scorecard, quit and you’re done.  Fast.

Q. I’ve got a bazillion rounds recorded in my Player file and Golf Personal seems to
be slowing down.  Any suggestions?

A. Player documents are very compact, but it’s true that using one with a
“bazillion” rounds in it can slow Golf Personal a bit.  From the Finder, make a
duplicate of your Player file.  Change its name to something useful, like your name
and “pre-1996 rounds”.  From Golf Personal, open this new Player document, select
your recent rounds (i.e.: for our example here, rounds in 1996 or later) and delete
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them.  Save and close that document.  Open your currently active Player document,
select the old rounds (i.e.: for our example here, rounds prior to 1996) and delete
them.  Save that document.  If you wish, before indiscriminately deleting all the old
rounds from your current document, you may wish to compare them to a copy of
your Stats & Records Report – so you can keep those old rounds that include
personal bests.

Expert Setup

Q. I’m sure there are convenient ways to use Mulligan’s Golf Personal to speed up
creating new Scorecards and adding players to them.  How do the experts do it?

A. The experts set up Golf Personal to display the toolbar (choose Show Toolbar in
the Windows menu) and put the toolbar at the top or left of their screen (choose
Toolbar Style – Top or Left in the Windows menu).  They also open the Players
palette (choose Show Players in the Windows menu) and leave it open all the time,
perhaps somewhere near the right side of their screen.  Golf Personal remembers
where it was last placed on the screen and opens it at that location each time it starts
up.  Drag a player’s name from the Players palette to a Scorecard window to add
them to the Scorecard.  Open a Player’s window by double-clicking their name in
the Players palette, or open a new Scorecard window with the player already
installed on it by option-double-clicking their name.  There’s a Clubs palette, too,
that will allow you to open a Club document window just by double-clicking.

Hiding Club and Player Documents

Q. I don’t want to throw away Club and Player documents I’ve created, but I’d like
to “hide” them from Golf Personal so it doesn’t recognize them when it starts up.
Since Golf Personal scans the entire contents of the application’s folder looking for
them, it seems that I have to put them somewhere outside the application’s folder.
Is that the best you can do?

A. No.  It’s true that you can hide a Club or Player document from Golf Personal at
startup by moving it outside the folder where Golf Personal is located.  You can also
create a folder whose name is parenthesized (begins with “(” and ends with “)” –
like a shield) inside the application’s folder, then drag the documents you want to
hide into that special folder.  Golf Personal won’t automatically look inside that
folder for Club or Player documents at startup, although you can tell it to open a
document inside one of these folders while you’re running Golf Personal.  This
“shielding” also works for hiding handicapping plugin files from Golf Personal, too.
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Remotely Located Clubs and Players

Q. I created and saved a new Player (or Club) on another disk drive, but when I
start up Golf Personal, it doesn’t find it.  Do all the Player and Club files have to be
inside the application’s folder?

A. If you create, or just retrieve with either the Add Player or Set Club options in
the Golf menu, a document file outside the application’s folder – in another folder,
another disk or over a network – that document is added to the list of available
Players or Clubs (and to the appropriate palette).  But, as you discovered – only
temporarily.  To have the “remote” Player or Club document show up automatically
when you restart Golf Personal, put an alias of the original file into the Players or
Clubs folder.  When you restart – provided the remote disk or system is available –
the remote file will be listed and available.

Tracking My Handicap

Q. I’m a member of a golf club that computes my “official” handicap.  I want to use
Golf Personal to verify the accuracy of my club’s computation, but the software
doesn’t seem to support the club’s method.  What do I do?

A. You need (or, your software needs) a handicapping plug-in for the method used
by your club.  Contact Mulligan Software for the appropriate plug-in.

Annoying Startup Messages

Q. I’m using one of those handicapping plug-ins to track my handicap and I
frequently get a message dialog when starting Golf Personal about that handicap-
ping method.  Can I make these messages go away?

A. Perhaps.  If the message is telling you that one of your handicapping plug-ins is
being used before it is effective, has expired, or is about to expire, you can get the
current plug-in for the handicapping method free from Mulligan Software.  Under
the licensing arrangements with some handicapping authorities, however, the
software is required to periodically display certain notices for your review.  The
regularity of their appearance is dictated by the licensor.
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Expired Handicapping Plug-Ins

Q. I get a message that one of my handicapping plug-ins is expired.  What can I do
about it?

A. Since most golf authorities periodically revise their handicapping systems, the
plug-ins for those systems expire and need to be updated to conform with the latest
version of the handicapping system.  You can contact Mulligan Software or visit the
Mulligan Software web site (http://www.mulligansw.com) to get an updater for the
plug-in.  If you don’t use the expired plug-in and just want to “hide” the expired
plug-in from Golf Personal, see the answer above about “Hiding Club and Player
Documents.”

Software Conflicts

Q. I think I may be having trouble running Golf Personal because of a software
conflict.  How can I find out about software that might conflict with the application?

A. Conflicts are rare, but they do occur.  Mulligan’s Golf Personal installs no special
extensions (beyond those from Apple required on older systems) for it to run.  If you
think you have identified a conflict, contact Mulligan Software customer support at
support@mulligansw.com.  Or, check Mulligan Software’s web site for any reports of
known conflicts.

Using Golf Personal for Leagues and Clubs

Q. Can I use Mulligan’s Golf Personal to compute stats and handicaps for my golf
league or golf club?

A. Mulligan’s Golf Personal has been designed for individual use.  Although it can
support any number of players and golf courses, it does not include features typi-
cally required for managing leagues or clubs, like comparative statistics, pairings,
standings or group reports.  Further, the USGA and other authorities license the use
of their formulas in this software only for a limited number of players.  There are
Mulligan’s Golf Personal users maintaining stats and handicapping data for a
substantial number of players using unrestricted handicapping methods.  We can
only recommend you try the capabilities of Golf Personal to see if it meets your
needs.
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Trivia

Q. Who is this Al Czervik who appears in all the sample documentation?

A. Al’s the newest member at Bushwood Country Club in the Warner Bros. movie
“Caddyshack” — the best golf movie ever made — starring Chevy Chase as Ty
Webb, Rodney Dangerfield as Al, Ted Knight as Judge Smails, Michael O’Keefe as
Danny Noonan and Bill Murray as Carl.  That hat looks good on you, though!


